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About the
Documentation

This manual is part of a set of Fiery Network Controller for C9800, herein referred to
as the “Fiery,” documentation that includes the following manuals for users and system
administrators. Most are available as Acrobat PDF (Portable Document Format) files
on the User Documentation CD.
• The Quick Start Guide summarizes the steps for configuring the Fiery and printing.
It also describes how to access the Acrobat PDF files on User Documentation CD.
• The User Software Installation Guide describes how to install software from the
User Software CD to enable users to print to the Fiery Network Controller for
C9800 with the EFI PostScript driver, and also describes setting up printing
connections to the Fiery.
• The Configuration Guide explains basic configuration and administration of
the Fiery for the supported platforms and network environments. It also includes
guidelines for setting up UNIX, Windows NT 4.0/2000/Server 2003, and Novell
NetWare servers to provide printing services to users.
• The Printing Guide describes the printing features of the Fiery for users who send
jobs from their computers using the EFI PostScript driver.
• The Colour Guide provides information on managing the colour output of the Fiery.
It explains how to calibrate your Fiery and take advantage of the ColorWise®
colour management system, as well as features in ColorWise Pro Tools™.
• The Fiery Colour Reference addresses concepts and issues associated with managing
colour output of the Fiery and outlines key workflow scenarios. In addition, it offers
information on printing colour documents from popular Microsoft Windows and
Apple Mac OS applications.
• The Job Management Guide explains the functions of the job management
utilities, including Command WorkStation™, Command WorkStation LE™, and
DocBuilder Pro™, and how you can use them to monitor and control jobs on the
Fiery. This manual is intended for an operator or administrator, or a user with the
necessary access privileges, who monitors and manages job flow, performs colour
calibration, and troubleshoots problems that may arise.
• Release Notes provide last-minute product information and workarounds for some of
the problems you may encounter.
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Introduction

This manual explains how to manage colour output on the Fiery, and provides
information on calibration and colour profiles.
This manual is part of a set of documentation that includes manuals for users and
system administrators. The other manuals are available at your site—refer to them for
a complete description of your Fiery.
N OTE : The term “Fiery” is used in this manual to refer to the Fiery Network Controller
for C9800. The name “Aero” is used in illustrations to represent the Fiery. The term
“Windows” is used to refer to Windows 98, Windows Me, Windows NT 4.0,
Windows 2000, Windows XP, and Windows Server 2003, wherever appropriate.
Illustrations of Windows software may not necessarily reflect the version of Windows
that you use.

About this manual
This manual is organized to supply you with key information about managing the
colour output of your Fiery.
• Chapter 1 describes the Fiery print options and how to get the best colour results.
• Chapter 2 covers various methods of calibrating the Fiery.
• Chapter 3 discusses the features of ColorWise Pro Tools. ColorWise Pro Tools
include Profile Manager, used to manage colour profiles on the Fiery, and Color
Editor, which allows you to customize simulation and output profiles. This chapter
also describes Spot-On®, which allows you to define CMYK equivalents for spot
colours. Spot-On® is a utility supplied with C9800 GA only. It is not available for
standard models.
• Appendix A provides information about setting up and calibrating colour
measurement instruments.
• Appendix B describes the Simple ASCII File Format (SAIFF), which can be used to
import toner density measurements from measurement devices.
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• The Fiery Colour Reference Glossary defines words in bold—for example, output
profile—that appear throughout this manual. Colour terms and concepts, such as
“colour space,” “spot colour,” “gamut,” and “source profile,” are used throughout
this manual. If you are new to desktop colour, or if any terms are unfamiliar, check
the Glossary.

Key features of ColorWise
ColorWise is the colour management system (CMS) built into the Fiery and designed
to provide both casual and expert users with the best colour output for a variety of
purposes. The ColorWise default settings provide high-quality out-of-box colour from
many Windows and Mac OS applications. This allows casual users to achieve quality
output without knowing about or changing any colour settings on the Fiery.
For consistent colour, calibrate the Fiery on a regular basis. ColorWise Pro Tools
include an easy-to-use calibrator, which allows you to calibrate using a
spectrophotometer or densitometer (see Chapter 2).
ColorWise features allow you to modify printing results. Depending on your particular
needs, you can:
• Set the behavior of CMYK printing to emulate DIC, Euroscale, and SWOP offset
press standards.
• Match PANTONE and other spot colours for the best match when printed using
four-colour press conditions or when printed using presses with extra, custom plates.
• Select a colour rendering dictionary (CRD), also called a rendering style, for RGB
printing. CRDs allow for rich, saturated printing of presentation graphics; smooth,
accurate printing of photographs; and relative or absolute colorimetric rendering for
specialized needs.
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• Define the source of incoming RGB colour data for better screen matching and
provide for better colour conversion of RGB data with no source information.
• Define whether RGB data is converted into the full gamut of the printer or whether
it is first converted into the gamut of another device, such as a press standard. This
feature is helpful for making one device behave like another. It is also useful for
evaluating the appearance of the RGB file under different printing conditions
without having to reprocess the RGB data each time.
ColorWise colour management (ColorWise) offers an open colour architecture,
allowing users to customize the Fiery to meet new printing needs as they arise.
ColorWise supports ICC profiles, which are industry standard colour profiles that
describe the colour behavior of a device. Downloading ICC profiles to the Fiery
enables the Fiery to simulate a custom press (or another printer), as well as accurately
print colours from a particular monitor or a scanner. In addition, you can create
customized ICC profiles for the printer.
ColorWise also allows you to use any Status T densitometer by importing data in a
standard file format (see Appendix B). In this case, it is important to note that the
quality of the instrument used will determine the quality of the calibration.
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Chapter 1:
Fiery Colour
Management

The following sections describe the options available from the ColorWise colour
management system and explain how to customize the colour settings for your
particular needs. They provide descriptions of the preset ColorWise default settings
and cover additional options for users who need to customize ColorWise.
For information on PostScript Level 2 or 3 printer drivers, see page 1-14. The section
also contains information on the capabilities of printer drivers and instructions for
setting colour options with the PostScript drivers for Windows and Mac OS
computers.

Managing colour on the Fiery
To modify printing behavior, do any of the following:
• Select ColorWise options for an individual print job using menus that appear in the
printer driver.
• Select most ColorWise options as server defaults from the “Color Setup” application
in ColorWise Pro Tools (see page 3-29). Defaults can also be set from Fiery Setup, as
described in the Configuration Guide Chapter 4. These defaults will apply to all
subsequent print jobs unless you override them.
• Select some ColorWise options, particularly default ICC profile settings and
calibration options, from ColorWise Pro Tools. These options include default
Simulation Profile (see page 1-10), CMYK Simulation Method (see page 1-11),
Appear in Driver as (see page 3-7), default Source Profile (see page 1-9), RGB
Separation (see page 1-12), and associated calibration set (see page 2-4).
Applications can generate colour data for the Fiery in many different colour spaces.
The most common type of colour data produced from office applications is RGB,
while prepress applications generally produce CMYK data. Desktop applications can
also generate spot colours, such as PANTONE colours. To complicate matters, a single
page may contain a mix of RGB, CMYK, and spot colours. The Fiery allows users to
control the printing of these mixed-colour documents with features that apply
specifically to RGB, CMYK, or spot colour data. Fiery colour management generates
CMYK data to be sent to the printer.
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The following diagram illustrates the print options in the Fiery colour management
process that affect colour data conversions. You can access these print options when
you send a print job to the Fiery. Most of these options and settings are described in
subsequent sections of this chapter.
RGB data

RGB Source Profile
Gamma
Phosphors
White Point
Rendering Style (CRD)
Black Overprint
Brightness
Pure Black Text/Graphics
RGB Separation
Output profile

CMYK data

Spot colour data

Fiery
colour
processor

colour data sent
to printer

CMYK Simulation Profile
CMYK Simulation Method
Black Overprint
Brightness
Pure Black Text/Graphics
Combine Separations
Output profile
Spot Colour Matching

RGB Source Profile is the only colour option that applies strictly to RGB colour data.
The other options that affect RGB colour also affect the more rarely used Lab, XYZ,
and other calibrated colour spaces.
N OTE : For users who are familiar with PostScript 3 colour, RGB Source Profile affects

all CIEBasedABC colour spaces (if the source space is RGB). If you send CMYK data
to the Fiery in CIEBasedDEFG format, for example, by choosing PostScript Colour
Management in Adobe Photoshop, the Fiery Rendering Style selection—which
normally affects only RGB data—will also affect this CMYK data.
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You can specify settings for the following options by selecting print options when you
send a job to the Fiery. Some can also be set as defaults by the administrator during
Fiery Setup or using ColorWise Pro Tools. Settings specified using print options override the defaults. Some options are only available with Spot-On, which is supplied
with C9800 GA only.
Fiery colour print option
Brightness

85% Lightest to 115% Darkest
CMYK Simulation Method

Quick/Full (Source GCR)/Full (Output
GCR)
(Default set at Setup or with ColorWise Pro
Tools)
CMYK Simulation Profile

SWOP-Coated (EFI)/DIC (EFI)/
Euroscale (EFI)/None
(Default set at Setup or in ColorWise Pro
Tools)
Color Mode (Mac OS)

CMYK/Grayscale
or

What it does
Performs a colour adjustment on all colour channels to make the printed
output lighter or darker.
Quick simulation applies one-dimensional transfer curves that adjust output
density only. The Full simulations apply colorimetric transformations that
adjust hue as well as output density (see page 1-11).

Adjusts CMYK colour data to simulate an offset press standard or a custom
colour gamut defined at your site. Choosing None bypasses simulation (see
page 1-10).

Specifies the output colour space of the job. Select CMYK, Standard Colour,
or Expert Colour for a full-colour document.

Print Mode (Windows)

Standard Colour/Expert Colour/Grayscale
(Other) Gamma

1.0/1.2/1.4/1.6/1.8/2.0/2.2/2.4/2.6/2.8/3.0
(Default set with ColorWise Pro Tools)
(Other) White Point

5000 K (D50)/5500 K/6500 K (D65)/
7500 K/9300 K
(Default set with ColorWise Pro Tools)
(Other) Phosphors

Hitachi EBU/Hitachi-Ikegami/NTSC/
Radius Pivot/SMPTE/Trinitron
(Default set with ColorWise Pro Tools)

Applies the specified gamma value to the RGB source space definition (see
page 1-9). To use this print option, you must choose Other as the RGB Source
Profile setting.
Applies the specified white point value to the RGB source colour space
definition (see page 1-9). To use this print option, you must choose Other as
the RGB Source Profile setting.
Applies the specified phosphor (monitor type) information to the RGB source
space definition (see page 1-9). To use this print option, you must choose
Other as the RGB Source Profile setting.
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Fiery colour print option
Output Profile

Output1-10
(Default set at Setup or with ColorWise Pro
Tools)
Pure Black Text/Graphics

On/Off
(Default set at Setup or with ColorWise Pro
Tools)
Rendering Style

Photographic/Presentation/Relative
Colorimetric/Absolute Colorimetric
(Default set at Setup or with ColorWise Pro
Tools)
RGB Separation

Output/Simulation
(Default set at Setup or with ColorWise Pro
Tools)

RGB Source Profile

EFIRGB/sRGB (PC)
/Apple Standard/Other/
None
(Default set at Setup or with ColorWise Pro
Tools)
Spot Colour Matching

On/Off
(Default set at Setup or with ColorWise Pro
Tools)

What it does
The output profile is applied to all data in the print job (see page 1-13). Userdefined output profiles can be downloaded to the Fiery using ColorWise Pro
Tools. For more information about using ColorWise Pro Tools, see Chapter 3.
The On setting optimizes the quality of black text and line art output (see
page 1-6).

Applies a Fiery colour rendering dictionary (CRD) to RGB data (see
page 1-5), or to any incoming data with a PostScript source colour space
definition, including CMYK.

Determines which CMYK colour space your original RGB data will be
separated into—CMYK for the printer (Output) or CMYK for a specified
simulation (Simulation). For more information, see page 1-12.
N OTE : When RGB Separation is set to Simulation, RGB colours are affected by
CMYK Simulation Profile and CMYK Simulation Method.
Applies an RGB source space definition to RGB data (see page 1-9). If you
choose the Other setting, you must also specify particular settings for Gamma,
Phosphors, and White Point. See the corresponding options in this table. This
option, along with Gamma, Phosphors, and White Point, only affects
DeviceRGB or calibrated RGB colour spaces.
The On setting enables Fiery-defined matching of spot colours to their best
CMYK equivalents. With Spot-On, you can manage and edit these spot colour
matches (see page 3-16). Off instructs the Fiery to match colour output to a
CMYK combination specified by the source application for the document (see
page 1-8).

Detailed explanations of how these and other settings affect your print jobs are
provided in subsequent sections of this chapter.
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Rendering Style
The Rendering Style option specifies a CRD for colour conversions. To control the
appearance of images, such as prints from office applications or RGB photographs
from Photoshop, select the appropriate Rendering Style. The Fiery allows you to select
from the four rendering styles currently found in industry standard ICC profiles.

Fiery rendering style

Best used for

Equivalent ICC
rendering style

Photographic—Typically results
in less saturated output than
presentation rendering when
printing out-of-gamut colours.
It preserves tonal relationships
in images.

Photographs, including scans
and images from stock
photography CDs and digital
camera images.

Image, Contrast, and
Perceptual

Presentation—Creates
saturated colours but does not
match printed colours precisely
to displayed colours. In-gamut
colours such as flesh tones are
rendered well; similar to the
Photographic rendering style.

Artwork and graphs in
presentations. In many cases, it
can be used for mixed pages
that contain both presentation
graphics and photographs.

Saturation, Graphics

Relative Colorimetric—Provides
white-point transformation
between the source and
destination white points. For
example, the bluish gray colour
of a monitor will map to neutral
gray. You may prefer this style
to avoid visible borders when
not printing full-bleed.

Advanced use when colour
matching is important, but you
prefer white colours in the
document to print as paper
white. It may also be used with
PostScript colour management
to affect CMYK data for
simulation purposes.

Relative Colorimetric

Absolute Colorimetric—

Situations when exact colours
are needed and visible borders
are not distracting. It may also
be used with PostScript colour
management to affect CMYK
data for simulation purposes.

Absolute Colorimetric

Provides no white point
transformation between the
source and destination white
points. For example, the bluish
gray of a monitor will map to a
bluish gray.
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Pure Black Text/Graphics
The Pure Black Text/Graphics option affects the printout for black text and vector
graphics on a page. Under most circumstances, leave this option set to On. When Pure
Black Text/Graphics is on, black colours generated by applications (for example, RGB
= 0, 0, 0; CMYK = 0%, 0%, 0%, 100%; or K = 100%) are printed using the
maximum amount of black toner allowed by the calibration curve. This means the
black text and line art will not exhibit halftone artifacts (as long as the printer is
calibrated correctly) and will not be misregistered, since there is only one toner used. In
addition, this setting eliminates blasting.
For some jobs, it is preferable to clear this option, for example, if the page includes
gradient fills that use black. The following table describes the behavior of the Pure
Black Text/Graphics option with black data defined in different colour spaces.
N OTE : Use the Pure Black Text/Graphics option only when printing composites, not

when printing separations.
Input
black
colour
RGB

Pure Black Text/Graphics
On
Prints 100% black

Off
With the default profile, prints a rich black using
all toners.

CMYK

Prints only with black toner, because CMYK
simulations preserve the black channel. The actual
amount of toner used depends on the current
simulation and the calibration state of the printer.

Spot

Prints only with black toner, because spot colour
simulations preserve the black channel. The actual
amount of toner used depends on the current
simulation and the calibration state of the printer.

N OTE : PostScript applications (such as QuarkXPress) may convert elements defined as

RGB = 0, 0, 0 to four-colour CMYK black before sending the job to the Fiery. These
elements are not affected by the Pure Black Text/Graphics option. For details, see the
application notes. Also, black text and line art defined as RGB = 0, 0, 0 in office
applications (such as Microsoft Word) are converted to single-colour black (CMYK =
0%, 0%, 0%, 100%) by the Microsoft PostScript Level 3 driver for Windows
2000/XP. To print this single-colour black at the maximum toner density of the
printer, set the Pure Black Text/Graphics option to On.
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Black Overprint
The Black Overprint option allows you to specify whether or not black text or
text/graphics—defined as RGB = 0, 0, 0, or as CMYK = 0%, 0%, 0%, 100%—
overprints coloured backgrounds.
• Text—Black text overprints coloured backgrounds, eliminating white gaps and
reducing halo effects or misregistration of colours.
• Text & Graphics—Black text and graphics overprint coloured backgrounds,
eliminating white gaps and reducing halo effects or misregistration of colours.
• Off—Black text or text/graphics knocks out coloured backgrounds.
N OTE : PostScript applications may perform their own black overprint conversions

before sending the print job to the Fiery.
One example of how you might use this setting is with a page that contains black text
on a light blue background. The background blue colour is CMYK = 40%, 30%, 0%,
0% and the black text is CMYK = 0%, 0%, 0%, 100%.
• With Black Overprint set to Text or Text & Graphics, the final text or text/graphic
portions of the page are overprinted, or combined with the underlying colours.
Black colours generated by applications (for example, RGB = 0%, 0%, 0%; CMYK
= 0%, 0%, 0%, 100%) are printed using the maximum amount of black toner
allowed by the calibration curve. This means that black text and line art will not
exhibit halftone artifacts (as long as the printer is calibrated correctly). There is no
transition in the cyan and magenta toners, and the quality of the output is improved
since it will not show artifacts near the edges of the text or text/graphics. The option
also works with text defined in the RGB colour space, that is RGB = 0, 0, 0.
• With Black Overprint Off, the border of the text or text/graphics is on an edge that
has cyan and magenta toners on one side (outside the text) and black toner on the
other side (inside the text). This transition may cause visible artifacts because of the
practical limitations of the printer.
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Spot Colour Matching
The Spot Colour Matching option provides automatic matching of spot colours with
their best CMYK equivalents.
• On—The Fiery uses a built-in table to generate the closest CMYK matches of spot
colours your printer can produce. (New tables are generated when you add new
output profiles.) With Spot-On, the Fiery uses the CMYK matches determined
through Spot-On (see page 3-16).
• Off—The Fiery uses CMYK equivalents defined by the spot colour manufacturer,
such as PANTONE. These are the same CMYK equivalents used by applications
that include spot colour libraries.
For jobs that include spot colours, set Spot Colour Matching to On unless you are
printing press simulations. In that case, set Spot Colour Matching to Off and choose
the appropriate CMYK Simulation setting (see page 1-10).
For PDF jobs that include spot colours and where the spot colours are not included in
the built-in table, setting Spot Colour Matching to On retains the spot colour
originally specified. The Fiery references the built-in table to generate the closest
CMYK matches of the original spot colour.
N OTE : Use the Spot Colour Matching option only when printing composites, not

when printing separations.
Spot Colour Matching and the PANTONE Coated Colour Reference
The PANTONE Coated Colour Reference (described in the Fiery Colour Reference
Chapter 4) prints differently depending on the Spot Colour Matching setting.
• On—The Fiery uses a built-in table or, with Spot-On, the Spot-On colour
dictionaries (see page 3-16) to generate the best matches of the PANTONE colours
that your C9800 can produce. The PANTONE number is printed below each
swatch.
• Off—The Fiery prints swatches using the CMYK values recommended by Pantone
Inc. (and used by applications that provide PANTONE colour libraries). The
CMYK values used to generate the colour, as well as the PANTONE number of the
colour, are printed below each swatch. These CMYK values are printed through the
selected CMYK Simulation and Output Profile settings.
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RGB Source Profile
The RGB source profile setting allows you to define the characteristics of the RGB
data in your document so the appropriate colour conversion can occur on the Fiery.
Commonly used monitor colour spaces are available from the printer driver and from
the ColorWise Pro Tools Profile Manager. For special needs, use ColorWise Pro Tools
to download custom monitor or scanner profiles.
When you specify a setting other than None for the RGB Source Profile, the Fiery
overrides source colour space definitions or profiles that other colour management
systems may have specified. For example, if you specified a ColorSync System Profile
on your Mac OS computer, the RGB Source Profile setting overrides it. In cases where
you do not want this setting to override another specified source colour space, choose
the None setting.
When you specify a setting other than None for the RGB Source Profile—since the
colour space definitions are overridden—the output from the Fiery is consistent across
platforms. The Fiery RGB Source Profile options are:
• EFIRGB specifies an EFI-defined colour space recommended for users who have no
detailed information about their RGB data.
• sRGB (PC) specifies the industry standard definition for a generic Windows
computer monitor.
• Apple Standard specifies the definition of all standard Mac OS computer monitors.
• Other allows you to specify custom RGB source settings. If you choose Other as the
RGB Source Profile setting, you must choose settings for the Gamma, Phosphors,
and White Point options.
• Sources 1-10 specify the definitions you download as RGB source profiles. For more
information about downloading RGB source profiles, see page 3-4.
If you are printing with the PostScript driver from a Windows computer and have
Two-Way Communication enabled, the name of each downloaded profile is
represented in the RGB Source Profile setting menu. If you are printing with the
AdobePS driver from a Mac OS computer, downloaded profiles appear as Source-1
through Source-10. For more information on Two-Way Communication, see
Chapter 1 of the User Software Installation Guide.
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• None instructs the Fiery to allow the RGB sources you defined elsewhere, such as in
the application, to be used. When you set RGB Source to None, the appearance of
colours will not be independent of the file type. For example, RGB EPS files will
look different from RGB TIFF files.
With RGB Source set to None, PostScript RGB data that contains a source colour
space definition is converted using the CRD specified by the Rendering Style option
(see page 1-5). Non-PostScript RGB data and PostScript RGB data that does not
contain a source colour space definition are converted using a general undercolour
removal (UCR) conversion method.

CMYK Simulation Profile
The CMYK Simulation Profile print option allows you to print press proofs or
simulations. This setting specifies the offset press standard or other colour printing
device that you want to simulate. This option affects CMYK data only.
With the Windows printer drivers, you can also view an unlimited number of custom
Full simulations created using ColorWise Pro Tools. On Mac OS computers, you can
view up to 10 Full custom simulations. The number of custom simulations is limited
by the disk space on the Fiery.
If you are printing with the PostScript driver from a Windows computer and have
Two-Way Communication enabled, the name of each downloaded or custom profile is
represented in the CMYK Simulation Profile setting menu. If you are printing with the
AdobePS driver from a Mac OS computer, downloaded or custom profiles appear as
Simulation-1 through Simulation-10. For more information on Two-Way
Communication, see the User Software Installation Guide Chapter 1.
The None setting sends your original CMYK data to the printer in its calibrated state,
without conversions to simulate another printer.
The CMYK Simulation Profile setting you specify depends on the press standard for
which the CMYK data was separated.
• For images that were separated using a custom separation (such as a separation
produced with an ICC profile), choose the corresponding profile on the Fiery with
the CMYK Simulation Profile setting.
• For images that were separated for SWOP, choose SWOP as the CMYK Simulation
Profile setting.
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N OTE : To properly simulate a printed image that was separated through the use of an

ICC profile, the same profile must be present on the Fiery. For more information
about downloading ICC profiles to the Fiery, see “Downloading profiles” on page 3-4.

CMYK Simulation Method
The CMYK Simulation Method allows you to define your preferred
CMYK-to-CMYK conversion technique.
• Quick applies one-dimensional transfer curves to adjust output densities in the cyan,
magenta, yellow, and black channels. This technique leads to pleasant colour output
from your printer because pure primary colours are not “contaminated” by other
colourants. While it is the fastest simulation method and perfect for drafts, avoid
using it for final documents that will be used as press proofs. Other techniques offer
more colour simulation accuracy, which is expected by proofing applications.
• Full (Source GCR) provides a complete and accurate simulation based on colorimetric
transformations. Hues are preserved, even for primary colours. The Gray
Component Replacement (GCR) level that was specified in the original (source)
document is also preserved. Full (Source GCR) is therefore an excellent simulation
technique for the highest quality press proofing applications.
• Full (Output GCR) is also a complete and accurate simulation method based on
colorimetric transformations. Hues are preserved, even for primary colours. With
this method, the Gray Component Replacement (GCR) level that was specified in
the original document is not preserved. Instead, all CMYK data is reseparated using
the GCR level specified by the Output Profile. This simulation technique is similar
to traditional ICC colour matching methods and is appropriate for most documents
designed for the press, but reproduced on your C9800.
N OTE : When you specify On for Pure Black Text/Graphics, and specify Full (Output

GCR) for CMYK Simulation Method, the black text and graphics in your document
are printed with 100% black-only toner.
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RGB Separation
The RGB Separation option determines how RGB colours (as well as Lab and XYZ
colours) are converted to CMYK. The name of this option is meant to be descriptive,
since the option defines the colour spaces that will be used by the Fiery to “separate”
the RGB data into CMYK values.
The two choices available for this option determine whether RGB data is converted
into the full gamut of the printer (see output profile) or is first converted into the
gamut of another digital printer or press standard (simulation). This feature is helpful
for making one device behave like another for RGB data. For example, if a high-quality
ICC profile is available for another print device, the Fiery can simulate the behavior of
that device.
RGB Separation is also useful for prepress applications. For example, it allows you to
experiment with the appearance of an RGB scan under different press printing
conditions, without having to convert the RGB data to CMYK data for each
condition. When the desired printing condition is found, convert the file to CMYK,
using the same CMYK simulation profile you used during the experimentation.
N OTE : The RGB Separation print option should be used in conjunction with the
Output Profile or CMYK Simulation Profile print options.

• Output converts all RGB colours into the CMYK colour space of your printer (when
set to the printer’s default), or a customized CMYK colour space for your printer
(when set to Output 1-10).
• Simulation converts all RGB colours into the CMYK colour space for a specified
simulation (select the desired simulation with the CMYK Simulation Profile print
option).
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Output profile
An output profile consists of a profile for your printer, describing its colour
characteristics.
In certain cases, you may want to customize the default output profile using the
ColorWise Pro Tools Color Editor to achieve particular colour effects (see page 3-9). If
you do so, the new customized output profile is applied to all data in the print job.
Changing the output profile does not affect its associated calibration target (since the
target is based on a printer model). You can edit D-Max values of the calibration target
separately (see page 3-9).
Use the ColorWise Pro Tools Profile Manager to download your own output profile to
the Fiery (see page 3-4). Downloaded output profiles are at first associated with the
calibration target that is tied to the default output profile. You can edit calibration
target D-Max values separately.
If you are printing with the PostScript driver from a Windows computer and have
enabled Two-Way Communication, the name of each downloaded or custom profile is
represented in the Output Profile setting menu. If you are printing with the AdobePS
driver from a Mac OS computer, downloaded or custom profiles appear as Output-1
through Output-10. For more information on Two-Way Communication, see the
User Software Installation Guide Chapter 1.

Combine Separations
The Combine Separations setting specifies how to print separated CMYK data. With
Spot-On, you can combine an unlimited number of spot colour separations along with
the CMYK separations.
The Combine Separations options are:
• Off prints each separation individually.
• On combines separations as a single, composite-colour document and automatically
makes these settings for the following print options: Colour Mode (CMYK),
Rendering Style (None), Pure Black Text/Graphics (Off ), Spot Colour Matching
(Off ), or Black Overprint (Off ).
For information about using the Combine Separations option with applications such
as Photoshop, see the Fiery Colour Reference.
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PostScript printer driver for Windows and Mac OS
To access the printer driver options described in this section, choose
Start > Settings > Printers (Windows 98/Me/NT/2000) or Printers and Faxes (Windows
XP/Server 2003), right-click the appropriate printer (PPD) name, and choose
Properties (Windows 98/Me), Document Defaults (Windows NT), or Printing
Preferences (Windows 2000/XP/Server 2003) from the pop-up menu. To access the
Mac OS driver options, choose Print from the File menu of your application. These
settings are also accessible from the Print Setup or Page Setup dialog boxes of most
applications.
For Windows computers, the Fiery driver interface allows you to save combinations of
settings for later access. Additionally, you can choose different settings for individual
jobs from the applications you use.
The printer driver writes a PostScript file containing the instructions generated by your
application and the Fiery print options you chose. The printer driver sends the
PostScript file to the Fiery. The Fiery then performs PostScript processing and colour
conversions and sends raster colour data to the print engine.
N OTE : The following illustrations and instructions do not apply to all applications.

Many applications, such as Adobe PageMaker, Adobe Photoshop, Adobe Illustrator,
QuarkXPress, and CorelDRAW, have other colour management options in addition to
those presented in the printer driver. For information on specific applications, see the
Fiery Colour Reference.

Setting colour management print options for Windows
This section explains how to set Fiery colour print options with the Adobe PostScript
Printer Driver for Windows. This driver is a PostScript 3 printer driver that takes full
advantage of the colour features of the Fiery. Before you proceed, complete the
following procedures:
• Install the Adobe PostScript Printer Driver and the Fiery PPD (see the
User Software Installation Guide Chapter 1).
• Set up the Fiery for printing (see the Configuration Guide).
• Install the ICC output profile for the Fiery on your Windows computer (see the
User Software Installation Guide Chapter 1).
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TO SET PRINT OPTIONS FOR W INDOWS
1. Access the printer driver options, as described on page 1-14.
2. Click the Fiery Printing tab, and choose settings from the ColorWise menu for the print
options described on page 1-3.
3. Click Expert Settings.

Click Expert Settings to access
additional ColorWise options

The Expert Color Settings flowchart appears. This window displays additional colour
settings for the Fiery. Each option includes a menu from which you select settings for
your specific job.
4. Click Update to display the current Fiery settings.

If Update does not appear, make sure that Two-Way Communication is set up as
described in the User Software Installation Guide Chapter 1.
5. To specify custom RGB source settings, select Other for the RGB Source Profile and
click Custom Setup.

The Custom Setup dialog box allows you to specify custom RGB source settings (see
page 1-9).

For most users, the default settings provide the right level of colour control. For more
information about individual print options, see page 1-3.
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Adobe PostScript printer driver for Mac OS
This section explains how to set colour management print options with the AdobePS
printer driver for Mac OS, a PostScript 3 driver that takes full advantage of the colour
features of the Fiery and allows you to save a set of print option settings.
Before you continue, complete the following procedures, as described in the
User Software Installation Guide Chapter 2 :
• Install the AdobePS printer driver and the Fiery PPD.
• Select the Fiery in the Chooser and set it up with the Fiery PPD.
• Install the ICC output profile for the Fiery on your Mac OS computer (see the
User Software Installation Guide Chapter 2).
N OTE : The following illustrations and instructions do not apply to all applications.

Many applications, such as Adobe PageMaker, Adobe Photoshop, Adobe Illustrator,
QuarkXPress, and CorelDRAW, have other colour management options in addition to
those presented in the printer driver. For information on specific applications, see the
Fiery Colour Reference.
Setting colour management print options
Choose settings for colour print options from the various panes of the AdobePS driver
dialog box. To access the initial AdobePS dialog box, choose Print from the File menu
of your application.
N OTE : The term “pane” is used to describe the different pages that appear in the driver

dialog box when you make selections from the menu at the upper-left corner of the
dialog box. Each pane presents a particular set of print options.
The AdobePS driver includes the following Colour Matching options.
• Color/Grayscale—When this setting is used to print to the Fiery, ColorWise
provides all colour conversions on the Fiery. Typically, use this option when printing
to the Fiery.
• PostScript Color Matching—Can be used with PostScript devices, such as the Fiery. It
provides for colour conversion using a colour rendering dictionary (CRD) that is
downloaded with the print job. This method requires that the file is saved as an EPS
with PostScript Colour Management selected.
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N OTE : If you use the PostScript Colour Matching option, the driver may, depending

on the application in use, attach a CMYK source definition to the CMYK data in
your document. In such a case, the CMYK data in the document is reseparated
using a Fiery CRD. The destination colour space for the CRD is determined by the
RGB Separation print option. When RGB Separation is set to Simulation, CMYK
data is printed according to all specified CMYK Simulation Profile and CMYK
Simulation Method settings. When RGB Separation is set to Output, CMYK data is
converted to the selected output profile’s CMYK colour space.
• ColorSync Color Matching—Provides for colour conversion on the host computer. This
option can be used with PostScript devices such as the Fiery, but it is intended for
use with PostScript Level 1 devices. If you use this option, you must specify the Fiery
ICC profile as the Printer Profile. ColorSync Color Matching is not a suggested
colour matching method because it does not work in conjunction with all
applications and requires that you disable features of ColorWise on the Fiery.
TO SET F IERY COLOUR MANAGEMENT OPTIONS
1. In the AdobePS Print dialog box, choose Color Matching from the menu.

Choose Color Matching
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2. Choose Color/Grayscale from the Print Color menu.

Choose Color/Grayscale

3. In the ColorWise menu, choose settings for the print options described on page 1-3. If
these settings are used regularly, click Save Settings to save them for subsequent jobs.
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TO SET FIERY COLOUR MANAGEMENT OPTIONS (M AC OS–X)
1. In the Print dialog box, choose Printer Features from the menu.

Choose Printer Features

2. In the ColorWise 1, ColorWise 2, and ColorWise 3 feature set menus, choose settings
for the print options described on page 1-3.

Choose ColorWise 1,
ColorWise 2, and ColorWise 3
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2

2-1 An overview of calibration

Chapter 2: Colour
Calibration

Calibrating the Fiery ensures consistent, reliable colour output. This chapter explains
how calibration works and provides instructions for all calibration procedures. You can
calibrate the Fiery using ColorWise Pro Tools in combination with any of the
following colour measurement instruments:
• EFI Spectrometer ES-1000 hand-held spectrometer
• EFI Densitometer ED-100 hand-held densitometer
• X-Rite DTP41 automatic scanning spectrophotometer
• X-Rite DTP32 automatic scanning densitometer
By connecting one of these instruments to a serial or USB port on your computer, you
can quickly measure calibration colour patches and download measurements to the
Fiery.
N OTE : To use the ES-1000 or ED-100 with a Mac OS computer, you must connect the

instrument to a USB port. For more information, contact your service
technician/representative. For information on setting up and operating the DTP41
and DTP32, see Appendix A.
For information on advanced calibration and simulation features available with
ColorWise Pro Tools, such as editing profiles and creating custom profiles, see
Chapter 3. A format for inputting colour measurements from other densitometers is
described in Appendix B.
N OTE : The procedures described in this chapter are fundamentally the same for

Windows and Mac OS computers. The main differences are the interface cable and the
port used to connect to the measurement instrument. The illustrations in this chapter
describe the Windows version.
N OTE : The term computer is used to refer to any computer running ColorWise Pro

Tools.
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An overview of calibration
Calibration generates curves that adjust for the difference between the actual toner
densities (measurements) and the response expected by the output profile.
• Measurements represent the actual colour behavior of the printer.
• Calibration sets are sets of measurements.
• A calibration target that describes the expected behavior of the printer is contained
in each output profile.
After you have calibrated the Fiery, a calibration set is stored. This calibration set will
be used when it is associated with an output profile. Every output profile has an
associated calibration set. If you have not specified one, the calibration set associated
with the default output profile is used.
If you change the calibration after a saved job has been processed (RIPped), you do not
need to reprocess (reRIP) the job. The new calibration affects the job without a need
for reprocessing.
N OTE : Changing calibration has the potential to affect all jobs for all users, so consider
limiting the number of people authorized to perform calibration. Set an Administrator
password in Fiery Setup to control access to calibration (see the Configuration Guide
Chapter 7).
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Understanding calibration
Although most users’ needs are met by the default calibration set, the Fiery allows you
to choose a calibration set to customize calibration for specialized jobs.
Calibration allows you to:
• Maximize the colour reproduction capabilities of the C9800.
• Ensure consistent colour quality over time.
• Produce consistent output across Fiery servers.
• Achieve better colour matches when reproducing spot colours, such as PANTONE
colours or other named colour systems.
• Optimize the Fiery for using ColorWise rendering styles (CRDs) and CMYK
simulations, and for using ICC profiles.

How calibration works
Success in obtaining satisfactory print quality from the Fiery depends on many factors.
Among the most important are establishing and maintaining optimal toner densities.
The density is the measure of the light absorbed by a surface. By carefully regulating
toner densities, you obtain consistent printed colour.
Even with a calibrated system, toner density is affected by service settings, humidity,
and temperature; density also tends to drift over time. Regular measurement detects
day-to-day variations in densities, and calibration corrects for them.
Calibration works by creating calibration curves on the Fiery that compensate for the
difference between actual (measured) and desired (target) density values. These
calibration curves are the graphic equivalent of transfer functions, which are
mathematical descriptions of changes that will be made to the initial data. Transfer
functions are often graphed as input or output curves.
The Fiery generates calibration curves after comparing measured values to the final
target values for each of the four toner colours. The target values are based on the
output profile specified.
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Measurements
Measurement files contain numerical values that correspond to the toner density
produced by the printer when it prints solid cyan, magenta, yellow, and black, and
graduated tints of those colours.
To create a measurement file, print a page of colour patches. Then measure the patches
using a colour measurement instrument connected to a computer on the network. The
new measurements are automatically downloaded to the Fiery.
Output profiles and calibration sets
Output profiles and calibration sets define desired calibration results. One or more
output profiles and calibration sets are provided with the Fiery. When you calibrate the
Fiery, select the calibration set that corresponds to the typical printing jobs at your site.
This same calibration set can be associated with one or more output profiles. For more
information on output profiles, see page 1-13.

Scheduling calibration
In general, you should calibrate the Fiery at least once a day, depending on the volume
of print jobs. If it is very important to maintain consistent colour, or if the printer is
subject to wide fluctuations in temperature or humidity, calibrate every few hours. For
optimal performance, calibrate whenever there is a noticeable change in print quality.
If you need to split a print job into two or more batches to be printed at different
times, it is especially important to calibrate before printing each batch. You should also
calibrate the Fiery after printer maintenance.
N OTE : Because printed output from the printer is very sensitive to changes in

temperature and humidity, the C9800 should not be installed near a window or in
direct sunlight, or near a heater or air conditioner. Paper is sensitive to climate changes
as well. It should be stored in a cool, dry, stable environment, and reams should remain
sealed until they are needed.

2

2-5 Understanding calibration

To monitor print quality, print the following colour reference pages:
• Colour Charts from the Control Panel (see the Configuration Guide Chapter 4)
• Colour Charts from Command WorkStation/Command WorkStation LE (see
“Printing Fiery Information Pages” in the Job Management Guide Chapter 2)
• Colour reference pages included with the user software (see “Introduction” in the
User Software Installation Guide)
All these pages include fully saturated colour patches and pale tints of cyan, magenta,
yellow, and black. Images with skin tones offer a very good basis for comparison. Save
and compare pages you printed at different times. If there is a noticeable change in
appearance, calibrate the Fiery.
When you examine the Test Page, all colour patches should be visible, even though
they may be very faint in the five percent and two percent range. Each colour’s patch
set should show uniform gradation from patch to patch as the colour lightens from
100 percent to zero percent.
If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated
with time, show the pages to your printer service technician to determine whether
adjusting the printer can improve output.

Checking calibration status
To verify whether the Fiery is calibrated, which calibration set and output profile were
used, and when the printer was last calibrated:
• Print a Configuration page or Test Page from the Control Panel or Command
WorkStation/Command WorkStation LE.
• Select a calibration set in Calibrator (available from ColorWise Pro Tools); the last
calibration and the user who performed it are displayed.
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Using Calibrator
ColorWise Pro Tools Calibrator allows you to calibrate the Fiery using the
measurement method of your choice.
Changing the calibration has the potential to affect all jobs for all users, so consider
limiting the number of people authorized to perform calibration. Set an Administrator
password to control access to calibration (see “Setting Passwords” in the
Configuration Guide Chapter 7).
N OTE : Multiple users can be connected to one Fiery with ColorWise Pro Tools, but

only one user at a time can use Calibrator. An error message appears if you try to
calibrate when another user is using ColorWise Pro Tools to calibrate.

Starting Calibrator
Start Calibrator from the ColorWise Pro Tools main window.
TO C ALIBRATE THE F IERY USING C ALIBRATOR
1. Start ColorWise Pro Tools and connect to the Fiery.

For instructions on configuring the connection to the Fiery, see the User Software
Installation Guide.
N OTE : If the connection to the Fiery from Command WorkStation/Command

WorkStation LE (which also allows for access to ColorWise Pro Tools) is not
established, you can start ColorWise Pro Tools independently of Command
WorkStation/Command WorkStation LE.
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2. Click Calibrator.

The Calibration window appears in Standard mode.

3. Use the Calibrator window to perform the calibration method of your choice.

Procedures for each calibration method are described in subsequent sections of this
chapter.
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Expert Mode
Calibrator provides two modes: Standard Mode and Expert Mode. You can perform all
essential calibration tasks while in Standard Mode. Expert Mode offers two additional
options: Print Pages and View Measurements.
TO U SE E XPERT M ODE
•

Move the sliding button at the top of the Calibration window from Standard to Expert.

The Expert Mode window appears.

With the Print Pages option, print a calibration Comparison Page showing the results
of the new measurements with any profile associated with the currently selected
calibration set. You can also create a custom comparison page and save it as a
PostScript or Encapsulated PostScript (EPS) file called CALIB.PS. Next, print the file
to the Hold queue of the Fiery from your application, or download it to the Hold
queue with Fiery Downloader. An additional way to create the CALIB.PS file is to
rename any job in the Hold queue using Command WorkStation/Command
WorkStation LE (see the table under “Using Commands” in the
Job Management Guide Chapter 2).
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With the View Measurements option, you can view the current set of measurements as
a table or graph that shows both the measurements and the target curves.

When more than one profile uses the same target, an additional menu called Plot
Against appears in the upper-right corner of the dialog box. It lists all output profiles
that use that same calibration set. Selecting an output profile from this menu displays
the target curves associated with that profile. If each output profile contains a unique
calibration target, the curves displayed also change when you switch profiles.

Restoring default calibration measurements
The C9800 is shipped with default calibration measurements. You can use these
measurements to achieve acceptable colour without calibration. If the measurement
device you use does not produce acceptable colour, you can easily return to the default
measurements.
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TO RESTORE DEFAULT CALIBRATION MEASUREMENTS
1. In the main Calibrator window, click Restore Device.
2. Click OK to restore the preset default calibration set.

N OTE : Restore Device applies only to the currently selected calibration set.
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Using the EFI Spectrometer ES-1000
The EFI Spectrometer ES-1000 is a hand-held spectrophotometer that measures the
spectral light reflected from printed output and other coloured materials, as well as the
density of printed ink and toner. It uses the density measurements to effectively
calibrate the Fiery.

Setting up the ES-1000
To use the ES-1000 for calibration purposes, you must first set it up for use with your
computer. For complete instructions on setting up the ES-1000, see the
documentation that is included with the instrument.
The following illustration shows the different parts of the ES-1000.

Measure button

Sample aperture

White tile reference

Calibration cradle

2

2-12 Colour Calibration

Calibrating the Fiery with the ES-1000
You can use ColorWise Pro Tools in conjunction with the ES-1000 to calibrate
the Fiery.
TO CALIBRATE THE F IERY USING THE ES-1000
1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
2. Choose EFI Spectrometer ES-1000 as the measurement method.
3. In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the mode and type of media which are
needed for calibration.
N OTE : For this calibration to take effect, the calibration set must be associated with one
or more output profiles. There is no need to make any new associations for the default
calibration set, since it is already associated with the default output profile.
4. In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.
5. Choose the appropriate options and click Print.

For Page Type, choose either 21 or 34 Sorted
Patches, or 21 or 34 Randomized Patches.
Sorted patches are printed on the page in the
order of their hue and saturation levels.
Randomized patches are printed on the page in
random order, to help compensate for density
inconsistencies on different areas of the page.
Page Size is automatically set to LTR/A4 for 21
patches, or 11x17/A3 for 34 patches.
Input Tray is automatically set to Auto Select.
6. Retrieve the printed measurement page from the printer.
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7. In the Get Measurements pane, click Measure.

The Measurement Options dialog box appears.
Page Type is automatically set to the type that
you selected in step 5.

8. Check the settings, and click
Measure.

The Information dialog box
appears.

9. Place the ES-1000 in the
calibration cradle, and click
OK.

The EFI Spectrometer
Measurement dialog box
appears. Directions for
measuring the strips appear in
the Status field.
N OTE : For a more accurate

measurement, place several
sheets of plain white paper
beneath the Measurement
Page to block underlying colours from being read by the instrument.
10. Place the sample aperture in the white space at the start of the specified colour.
11. Press and hold the measure button and wait for a beep.
N OTE : To hear a beep with a Windows compatible computer, you must have a sound

card and speaker(s) installed.
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12. After you hear a beep, slide the ES-1000 at a slow but consistent pace across
the strip.
13. Release the button when all the patches in the strip have been measured, and you
have reached the white space at the end of the strip.

When a strip is measured successfully, the cross hair moves to the next colour.
14. Repeat step 10 through step 13 until all the strips have been measured.
N OTE : You must take the measurements in the order outlined in the Status field.
15. When all the patches have been read successfully, click Accept.
16. Click Apply in the Calibrator window to implement the new calibration measurement.
17. Click OK in the Information dialog box.

This completes the Fiery calibration process.

Using the EFI Densitometer ED-100
The EFI Densitometer ED-100 is a hand-held instrument that measures the density of
printed ink and toner. Like the DTP32, the ED-100 is a reflection densitometer that
you can use to calibrate the Fiery.

Setting up the ED-100
To use the ED-100 for calibration purposes, you must first set it up for use with your
computer. For complete instructions on setting up the ED-100, see the documentation
that is included with the instrument.
The following illustration shows the components of the ED-100.
Indicator light
Measure button

Sample aperture
(underneath)
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Calibrating the Fiery with the ED-100
You can use ColorWise Pro Tools in conjunction with the ED-100 to calibrate the
Fiery.
TO CALIBRATE THE F IERY USING THE ED-100
1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
2. Choose EFI Densitometer ED-100 as the measurement method.
3. In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the type of media you will use most often.
N OTE : For this calibration to take effect, the calibration set must be associated with one
or more output profiles. There is no need to make any new associations for the default
calibration set, since it is already associated with the default output profile.
4. In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.
5. Choose the appropriate options and click Print.

For Page Type, choose 21 Sorted Patches.
Sorted patches are printed on the page in the
order of their hue and saturation levels.
Paper Size is automatically set to LTR/A4 for
21 Patches.
For Input Tray, specify the paper source for
printing the measurement page.
6. Retrieve the measurement page from the
printer.
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7. Click Measure in the Get Measurements pane.

The Measurement Options dialog box appears.
8. Choose the appropriate options, and then click
Start.

Page Type is automatically set to the
measurement page type that you printed in
step 5.
Use the arrow buttons next to the Clicks Per
Patch field to choose the number of
measurements you want to take for each patch
on the page. When you choose multiple clicks,
the average value of all measurements taken for the patch is returned to the Fiery.
Multiple measurements are more accurate, but may take more time.
To hear a confirmation tone each time a measurement is recorded, select the Audio
Feedback option. A single tone indicates a successful measurement; two tones indicate
a measurement error. If you have specified multiple clicks per patch, the tone sounds
after you take the final measurement.
If necessary, choose the appropriate COM port for the ED-100 from the Port menu.
When you click Start, the Measurements window appears. Directions for measuring
the patches appear in the Status area.
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9. Place the ED-100 over the specified patch on the Measurement Page, making sure to
center the sample aperture over the patch. Press Measure to take the measurement.
N OTE : For a more accurate measurement, place

several plain sheets of paper beneath the
Measurement Page to block underlying colours
from being read by the instrument.
If you have specified multiple clicks per patch,
continue pressing Measure to take the required
number of measurements. We recommend that
you move the ED-100 slightly after each
measurement while keeping it within the patch
circle.
When the patch has been measured successfully, a
check mark appears in the patch preview in the
Measurements window. The window identifies
and highlights the next patch to be measured.
10. Repeat step 9 to measure each successive patch on the Measurement Page.

Start with A1 and continue down Column A. When you have finished measuring all
the patches in Column A, proceed to Column B in the same manner until all columns
have been measured.
To retake a measurement, select the desired patch preview in the Measurements
window and measure the patch on the page using the ED-100.
N OTE : You must take the measurements in the order outlined in the Measurements

window and on the measurement page.
11. When all the patches have been read successfully, click Accept.
12. Click Apply in the Calibrator window to implement the new calibration set.
13. Click OK in the Information dialog box.
N OTE : This completes the Fiery calibration process.
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Calibrating the Fiery with the DTP41
Using the ColorWise Pro Tools Calibrator application and the DTP41
spectrophotometer, you can quickly measure colour patches printed by the C9800 and
automatically download these measurements to the Fiery.
N OTE : Before using ColorWise Pro Tools and the DTP41 to calibrate the Fiery, follow

the instructions on page A-4 for calibrating the DTP41 spectrophotometer.
TO CALIBRATE THE F IERY USING THE DTP41
1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
2. Choose X-Rite DTP41 as the measurement method.
3. In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the type of media you use most often.
N OTE : For this calibration to take effect, the calibration set must be associated with one
or more output profiles. There is no need to make any new associations for the default
calibration set, since it is already associated with the default output profile.
4. In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.
5. Choose the appropriate options, and click Print.

For Page Type, choose either 21 or 34 Sorted
Patches.
Paper Size is automatically set to LTR/A4 for
21 Sorted Patches, or 11x17/A3 for 34 Sorted
Patches.
For Input Tray, choose the paper source for
printing the measurement page.
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6. Retrieve the measurement page from the printer.
7. In the Get Measurements pane, click Measure.

The Measurement Options dialog box displays the specified Page Type and Paper
Size options.
8. Click Measure.
9. If necessary, choose the appropriate COM port for the DTP41 from the Available Ports
menu. Click Start Measurements.

10. Insert the
measurement page into
the DTP41, starting
with the cyan strip.

Follow the on-screen
instructions to align
the page properly.
11. Click Read Strip.

The DTP41 pulls the
measurement page
through automatically.
After the measurement
page is read, Calibrator instructs you to insert and align the page again for the
next colour.
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12. Repeat the measurement process for the magenta, yellow, and black strips.

A check mark appears
on the circle of the
colour just read, and
the Status field
indicates the colour
was measured
successfully.
Click Previous and
Next to reverse or
advance to another step
in the measurement
sequence.
13. When the Status field indicates that all four colour strips have been read successfully,
click Accept Measurements.
14. In the Measure dialog box, click OK.
15. Click Apply in the Calibrator window to implement the new calibration set.
16. Click OK in the Information dialog box.

This completes the Fiery calibration process.
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Calibrating the Fiery with the DTP32
Using the DTP32, you can quickly measure colour patches and download these
measurements to the Fiery using ColorWise Pro Tools Calibrator.
N OTE : Before using ColorWise Pro Tools and the DTP32 to calibrate the Fiery, follow

the instructions on page A-10 for calibrating the DTP32 densitometer.
TO CALIBRATE THE F IERY USING THE DTP32
1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
2. In the Select Measurement Method pane, choose X-Rite DTP32.
3. In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the type of media you will use most often.
N OTE : For this calibration to take effect, the calibration set must be associated with one

or more output profiles. The default calibration set is already associated with the
default output profile, so there is no need to make any new associations.
4. In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.
5. Choose the appropriate options, and click Print.

For Page Type, choose either 34 or 21 Sorted
Patches.
Paper Size is automatically set to LTR/A4 for
21 Sorted Patches, or 11x17/A3 for 34 Sorted
Patches.
For Input Tray, specify the paper source.
6. Retrieve the measurement page from the
printer.
7. Click Measure in the Get Measurements pane.

The Measurement Options dialog box displays the specified Page Type and Paper Size
options.
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8. Click Measure.

In the dialog box that
appears, follow the
directions for feeding the
measurement page through
the X-Rite DTP32.
The Status field displays
instructions for selecting the
port and feeding the
measurement page through
the DTP32 four times, once
for each colour strip.
9. When the Status field indicates that the measurements were read successfully, click
Accept.
10. Click OK in the Measure dialog box.
11. Click Apply in the Calibrator window to implement the new calibration set.
12. Click OK in the Information dialog box.

This completes the Fiery calibration process.
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Chapter 3:
ColorWise
Pro Tools

Designed to give you flexible control of colour printing, ColorWise Pro Tools include
the following colour management tools:
• Calibrator (see Chapter 2)
• Colour Editor
• Profile Manager
• Spot-On (C9800 GA only)
• Colour Setup

ColorWise Pro Tools for Windows and Mac OS computers are fundamentally the
same; differences are noted in this chapter. The windows and dialog boxes illustrated
are the Windows versions. For information on installing and configuring a connection
to ColorWise Pro Tools, see the User Software Installation Guide.
N OTE : If the connection to the Fiery from Command WorkStation/Command

WorkStation LE (which also allows for access to ColorWise Pro Tools) is not
established, you can start ColorWise Pro Tools independently of Command
WorkStation/Command WorkStation LE.
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Profile Manager
Profile Manager allows you to manage and edit ICC profiles. In the case of the Fiery,
these profiles are divided into RGB Source, Simulation, and Output profiles:
• RGB Source contains all monitor profiles resident on the Fiery. RGB Source profiles
are used to define the source colour space for RGB colours processed by the Fiery.
N OTE : If you use Photoshop 5.x, 6.x, or 7.x, you can upload the profile for your

selected working space to the Fiery and choose that as your RGB Source Profile. For
more information, see the Fiery Colour Reference Chapter 5.
• Simulation contains printer profiles used to simulate another device on the Fiery.
• Output contains printer profiles that describe the printer. For more information on
output profiles, see page 1-13.
N OTE : Changing the Fiery default profiles affects all jobs for all users. Consider

limiting the number of people authorized to use ColorWise Pro Tools by setting an
Administrator password.
The following profiles are provided with the Fiery.
RGB Source:
• Apple Standard—standard source colour space for Mac OS computer monitors with
older versions of ColorSync
• sRGB (PC)—source colour space for a generic Windows computer monitor
• EFIRGB—preset default setting for a Fiery
Simulation:
• DIC—Japanese press standard
• Euroscale—European press standard
• SWOP-Coated—United States press standard
In addition, one or more output profiles are provided with the Fiery. For information
about output profiles, see page 1-13.
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N OTE : When you use Profile Manager from some Windows NT computers, the default

colour directory may not be created automatically when ColorWise Pro Tools are
installed. Create the colour folder in the appropriate directory (for example,
C:\WinNT\system32\color) and Profile Manager will be able to download and upload
from the default location as expected.

Setting the default profiles
You can use Profile Manager to set a default RGB source profile, simulation profile,
and output profile. The default RGB source and simulation profiles that you set are
applied to all print jobs sent to the Fiery, unless you override them using print options.
The same is true of the default output profile that you set.
TO SPECIFY A DEFAULT PROFILE
1. Start ColorWise Pro Tools and click Profile Manager.

The left side of the main Profile Manager window lists the ICC profiles in the default
directory of your computer; the right side lists the three profiles on the Fiery.
The Lock icon ( ) to the left of a profile name indicates that the profile cannot be
deleted and can be edited only if saved under a new name. Only Simulation and
Output profiles can be edited.
A small icon to the left of a profile name indicates the default profile for each category
(RGB Source, Simulation, and Output). If you designate a different profile as the
default, the icon appears next to your designated profile. The icon indicating the
default RGB Source and Output profiles looks like a target ( ). The icon indicating
the default Simulation profile changes in appearance depending on whether the default
RGB Separation setting is set to Simulation ( ) or Output ( ).
2. Select the profile you want as the default for a profile type and click Profile Settings.
3. In the Profile Settings dialog box, click Default and click Apply.
4. Click OK.

In the main Profile Manager window, the target icon appears next to the new default
profile you specified.
5. Repeat steps 2 through 4 for each type of profile.
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If no default is set for RGB Source, the RGB Source print option is set to None. If no
default profile is set for Simulation, the CMYK Simulation print option is set to None.
For more information on print options, see Chapter 1.
The Output profile always has a default profile. To change the Output default, select a
preset profile you want as the default and click Profile Settings. Or create a new default
under a new name by selecting a preset profile and specifying your choice of the
calibration set in the Use Calibration Set menu and a new name in the Profile
Description menu.

Downloading profiles
The Fiery includes default profiles. You can download additional profiles from any
computer connected to the Fiery.
TO DOWNLOAD A PROFILE
1. Start ColorWise Pro Tools and click Profile Manager.

The left side of the main Profile Manager window lists the ICC profiles in the default
location on your computer.
• Windows 98/Me—Windows\System\Color
• Windows NT 4.0—Winnt\System32 \Color
• Windows 2000—Winnt\System32\Spool\Drivers\Color
• Windows XP/Server 2003—Windows\System32\Spool\Drivers\Color
• Mac OS 9.x—System Folder: Preferences : ColorSync Profiles for ColorSync 2.0, and
System Folder : ColorSync Profiles for ColorSync 2.5 or later
• Mac OS X—System : Library : ColorSync : Profiles
2. If the desired profile does not appear, click Browse to go to a different directory.
Browse to the directory containing the profile you want to download and click OK.
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3. When the profile you want to download appears in the list in the main Profile Manager
window, select it.

If the profile is compatible with the Fiery, a green arrow indicates that the
profile is available for downloading. Only output device profiles are
downloadable to Simulation and Output. Only input device profiles are
downloadable to RGB Source.
N OTE : On Windows computers, the profiles must have an extension of .icc or .icm to

be listed. On Mac OS computers, the profiles must have a file type of “profile.”
All ICC profiles in the selected directory on your computer are displayed in the list in
the main Profile Manager window. However, because a profile is listed does not
necessarily mean it can be downloaded to the Fiery.
Simulation profiles should be profiles only for those devices you want the Fiery to
match in terms of colour output characteristics. Output profiles should be profiles only
for the printer to which you print. Although you can download CMYK printer profiles
as Simulation or Output, consider how they will be used. If you want the Fiery prints
to look like another printer, download that profile as a Simulation.
4. Click the arrow to download the profile and click OK when the download is complete.

The new profile now appears in the list of profiles on the right side of the Profile
Manager main window.
For Mac OS computers, this profile must be associated with one of the predefined
names (Source-1 through Source-10 for RGB Source, Simulation-1 through
Simulation-10 for Simulation, or Output-1 through Output-10 for Output) or set as
the default before it can be used. For Windows computers, all profiles can appear in
the printer driver by their profile descriptions (see “Defining profiles” on page 3-7).
N OTE : When an output profile is downloaded, it inherits the calibration target of the
current default output profile.

Editing profiles
You can customize the profiles on the Fiery to meet your specific needs and the
characteristics of your C9800 printer using Colour Editor, either directly or through
Profile Manager. For more information on editing profiles, see “Colour Editor” on
page 3-9.
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Managing profiles
Profile Manager allows you to back up profiles to ensure that no custom profiles are
lost when the Fiery software is updated. You can also upload a copy of a built-in Fiery
profile to your workstation in order to use it with an ICC-aware application, such as
Photoshop. Profile Manager also allows you to delete unwanted profiles.
N OTE : You can back up and delete only those profiles that appear in the main Profile

Manager window without a Lock icon next to them. Locked profiles cannot be deleted,
but most can be backed up.
TO BACK UP PROFILES
1. Start ColorWise Pro Tools and click Profile Manager.
2. Select the profile on the Fiery to upload.

The arrow in the middle of the Profile Manager window turns green and points to the
left, indicating the profile is available for upload.
3. Click the green arrow, choose a name and location for the profile, and click Save.

The name will be the file name of the profile, but the profile description will be the
original description, or the one you entered in the Profile Settings dialog box.
N OTE : When saving the profile on a Windows computer, include the extension .icm. If

the extension is not included, additional dialog boxes appear.
4. Click OK when you are notified that the profile was successfully uploaded.

Delete profiles to ensure that the wrong profiles are not used, and to free up disk space
on the Fiery (although profiles are small and do not take up much space).
TO DELETE PROFILES FROM THE F IERY
1. Start ColorWise Pro Tools and click Profile Manager.
2. Select the profile you want to delete and click Delete.

A Warning dialog box asks you to confirm the deletion.
N OTE : You cannot delete preset profiles, profiles that are currently set as default, or

profiles that are linked to any of the predefined custom names, for example
Simulation-1.
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3. Click Yes to delete the profile.
4. To delete a profile currently set as the default or associated with a custom name, click
Profile Settings and clear the default option.

Defining profiles
For Mac OS computers, before you apply any downloaded or edited profile to a print
job, that profile must be linked to one of the predefined custom names, or you can set
the profile as the default for all print jobs (see “Setting the default profiles” on
page 3-3). Ten names are available for custom profiles—Source-1 through Source-10
for RGB Source, Simulation-1 through Simulation-10 for Simulation, or Output-1
through Output-10 for Output.
For Windows computers, all profiles appear by their actual names in the printer driver.
These fixed names are used in the printer driver, so you can select profiles per job even
if your driver does not have the capability to obtain an updated list from the Fiery.
N OTE : A custom simulation profile is used to illustrate this procedure. The same steps
apply for defining output profiles.

TO DEFINE A CUSTOM SIMULATION PROFILE
1. Start ColorWise Pro Tools and click Profile Manager.

Custom profile
created with
Colour Editor

For the purposes of this example, assume DIC-new is a custom simulation profile
created with Colour Editor and, as such, no information is displayed for DIC-new
under the heading “Appear in Driver as.”
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N OTE : You can define custom profiles only. Default profiles are predefined and cannot
be changed.
2. Select DIC-new in the Simulation list, and click Profile Settings or double-click
DIC-new.
3. Select the “Appear in Driver as” option, choose one of the predefined custom
simulation names (Simulation-1 through Simulation-10) from the menu, and then
click Apply.
N OTE : Choose a name that is not already linked with another simulation. You cannot
define two profiles with the same name.
N OTE : Although you cannot delete a preset profile, you can use the name of a preset

profile for your edited profile when you select the “Appear in Driver as” option. This
replaces the preset profile with your own profile.

In Profile Settings, you can also change profile descriptions for all non-locked profiles.
4. Click OK.

Simulation-1 now appears under the “Appear in Driver as” column for DIC-new.
Choosing Simulation-1 from the CMYK Simulation option of the printer driver
applies the DIC-new simulation to the print job.
If you do not define a custom simulation profile, your job will print with CMYK
Simulation Profile set to None. If you do not define a custom RGB Source or Output
profile, the default profile is used.
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Considerations for defining Output Profiles
The procedures for defining Output Profiles is similar to the preceding example for
defining Simulations profiles. However, note these differences:
For output profiles, the predefined custom names are Output-1 through Output-10.
When you choose Profile Settings for an output profile, the Use Calibration Set
options also appear. You must calibrate the Fiery with this calibration set before this
option has any effect. If you have never measured for this calibration set, default
measurements are used. For more information about calibration sets, see page 2-3.

Colour Editor
Colour Editor allows you to customize simulation and output profiles. Access Colour
Editor directly by clicking its icon in the ColorWise Pro Tools main window, or
indirectly, through the Profile Manager.

Editing profiles
Colour Editor allows you to create custom profiles by editing existing simulation or
output profiles and saving the changes as a new profile. Use Colour Editor to fine-tune
a profile on your Fiery to meet your exact specifications. For example, you can create a
custom profile for printing to a specific media type.
N OTE : You cannot edit source profiles; only simulation and output profiles can be

customized.
Colour Editor has two Edit Modes for editing output profiles:
• Custom—Edit output profiles and save customized versions of them.
• % Density—View the calibration target, which is one component of the output
profile. You cannot make changes to the calibration target in this window, but you
can import a new target (see page 2-3).
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Colour Editor also has several Edit Modes for editing simulations:
• Master—Create a custom master simulation that affects all print jobs to which it is
applied, unless a linked simulation exists for the selected combination of simulation
profile, simulation method, and output profile.
• Quick, Full (Source GCR), or Full (Output GCR)—Create custom linked simulations.
Linked simulations affect the print job only if the corresponding simulation profile,
simulation method, and output profile are selected. If you choose an output profile
and simulation method for which you have created a custom linked simulation, that
simulation is applied automatically to the job. If you choose a simulation method or
output profile for which there is no custom linked simulation, the master simulation
is automatically applied. For detailed information about simulation methods, see
page 1-11.
N OTE : If you made edits to a master simulation after you created a linked simulation,

the edits are not applied to the linked simulation.
TO EDIT A SIMULATION PROFILE IN M ASTER M ODE OR AN
OUTPUT PROFILE IN C USTOM M ODE
1. Start ColorWise Pro Tools and click Colour Editor.
2. Choose Simulation or Output from the View menu.

Simulation lists the simulation profiles resident on the Fiery, and Output lists the
output profiles resident on the Fiery.
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3. Choose a profile to edit and click Select.

Another method is to open the Profile Manager, select a profile, and then click Edit.
4. For a simulation profile, choose Master from the Edit Mode menu. For an output
profile, choose Custom from the Edit Mode menu.

For instructions for using Quick, Full (Source GCR), or Full (Output GCR) mode, see
page 3-14.
Use this dialog box to view
or edit profiles. The graph
allows you to view and
manipulate colour output
values.
N OTE : When you edit an

output profile in Custom
mode, clicking Import at
the bottom of the Colour
Editor window allows you
to import a calibration
target file (.trg) created on
another Fiery using the
previous version of
ColorWise. The current
version of ColorWise does
not allow you to save a
target separately; rather, it
saves the target in
conjunction with an
output profile.
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5. Select the colours you want to edit by turning colours off and on.

The Eye icon to the left of each colour indicates whether that colour is
visible on the graph and will be affected by changes to the curves,
brightness, and dot gain controls. You can view and edit all four colours
(cyan, magenta, yellow, and black) at once, or in any combination.
Working with only one or two colours at a time allows you to fine-tune
your adjustments. To turn off a colour, click its Eye icon. In the following
example, cyan and magenta are visible and can be edited.
6. To adjust the dot gain value for
simulating press output, click Dot Gain.

Choose either the North American or
European standard. Use the sliders to
adjust to the desired Dot Gain:
• The range of values for North
American at 50% input are from 0%
to 50% gain on output.
• The range of values for European at
40% input are from 0% to 59% gain
on output; the range of values for
European at 80% input are from 0%
to 20% gain on output.
If you use Dot Gain values, apply the settings first, so that the curves are deflected
from their straight-line positions. Then make edits to the new curves. When you
adjust Dot Gain values, all existing points on the curve are removed. A warning dialog
box allows you to cancel Dot Gain settings before they are applied.
7. Use the plus and minus buttons to adjust brightness.

Changes to the brightness are reflected in the curve(s).
8. To adjust the curves directly, click and drag points on the curve or enter numbers into
the input and output boxes.

The graph maps the input percentage to the output percentage. (These percentages
refer to the size of the CMYK halftone dots.) The curve you selected appears, and
points along the curve are marked so you can adjust them.
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A curve with this shape
makes a colour appear
darker by adding density
in the midtones.

A curve with this shape
makes a colour appear
lighter by reducing
density in the midtones.

A curve with this shape
increases contrast.

N OTE : Adjust points in this way only after you have entered the Dot Gain and

Brightness values.
For greater precision, type percentages in the Input and Output fields or use the arrow
keys on the keyboard to adjust the curve. To use the arrow keys, you must first click the
curve to establish an anchor point that serves as a reference.
9. For an output profile, set maximum densities of the C, M, Y, and K channels.

Enter the maximum densities, called D-Max values, of individual colours for profiles
that support density settings. D-Max settings are not available when you edit
Simulation profiles in Master mode.
10. When you are finished, click Save and enter a name for the new profile.

The new custom profile is saved to the Fiery with the new name. If you edit one of the
press standard targets (for example, SWOP-Coated, DIC, or Euroscale), consider
including the original name as part of the new target name (for example, DIC-new) to
help you remember the source of the new target.
N OTE : Preset default profiles are locked and must be saved with a new name.

For Mac OS computers, custom profiles must be linked to one of the ten predefined
custom profile names (Simulation-1 through Simulation-10 for Simulation, or
Output-1 through Output-10 for Output) to be accessible from the printer driver.
Create as many custom profiles as you want, but a maximum of ten are available from
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the printer driver at any one time. For information on linking custom profiles to the
predefined custom profile names, see “Defining profiles” on page 3-7. If you are using
the printer driver for Windows computers, custom profiles will appear in the driver
window without being associated with a predefined profile name.
If you set a custom profile as the default, you can access it from the printer driver
without linking it to one of the predefined custom names. Select Printer’s default from
the printer driver.
TO EDIT A SIMULATION IN Q UICK , F ULL (S OURCE GCR),
OR F ULL (O UTPUT GCR) MODE
1. Start ColorWise Pro Tools and click Colour Editor.
2. Choose Simulation from the View menu, select the simulation profile to edit, and then
click Select.

Another method is to open the Profile Manager, select a simulation profile, and
click Edit.
3. Choose Quick, Full (Source GCR), or Full (Output GCR) from the Edit Mode menu, and
choose an output profile with which your edited simulation will be linked from the
Link with menu.

The edited simulation will be linked with the output profile you choose from the
“Link with” menu.
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N OTE : When editing a simulation profile in Quick mode, clicking Import at the

bottom of the Colour Editor window allows you to import a custom Quick Simulation
created on another Fiery using the previous version of ColorWise. The current version
of ColorWise does not allow you to save custom CMYK Quick, Full (Source GCR) or
Full (Output GCR) Simulations independently; rather, they are saved as components
of the same profile.
4. Edit and save the simulation, as described in steps 5 through 10 of the procedure
starting on page 3-12.

For this new simulation to be automatically applied to a print job, the CMYK
Simulation, Simulation Method, and Output Profile settings must be the same as those
used when you edited the profile. If the Simulation Method is different or a different
output profile is selected, the Master simulation is applied.
N OTE : A CMYK Simulation Profile can have a custom Master and one or more custom

links—up to three links (Quick mode and the two Full modes) for each output profile
on the system. For the CMYK Simulation Profile option in the printer driver, note that
if you select a custom profile for which the output ink percentage is greater than 0 and
the input ink percentage is 0, the Use Master print option will have no effect.

Undoing CMYK simulation edits
You can undo the changes you made to CMYK simulations (master and linked) in the
following ways:
• If you have not yet saved your edits, click Done on the Colour Editor menu bar and
do not save the changes.
• If you saved your edits under a new CMYK simulation name and want to delete all
edits—in Master, Quick, and Full (Source GCR) or Full (Output GCR) modes—to
the simulation, see page 3-6.

Checking edited profiles
To view a printed sample of a profile before you save it to the Fiery, print one of the
following:
• Comparison Page provided with ColorWise Pro Tools, which shows a comparison of
images and coloured patches with and without edits
• User-defined CALIB.PS in the Hold queue
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You can create a custom comparison page and save it as a PostScript or Encapsulated
PostScript (EPS) file called CALIB.PS. Print the file to the Hold queue of the Fiery
from your application, or download it to the Hold queue with Fiery Downloader (see
page 2-8).
TO CHECK A PROFILE
1. Click Test Print from the Colour Editor window.
2. Select a page to print. If you selected Comparison Page, choose a paper size and input
tray. If you selected Sample Image Page, choose an output profile. Then click Print.

Using Spot-On
N OTE : The Spot-On utility is included with C9800 GA models only. It cannot be used

with other C9800 models.
The ColorWise Spot Colour Matching option automatically matches spot colours
with their best CMYK equivalents so that spot colours can be simulated using the
CMYK toner of the printer. However, you may want to adjust the default CMYK
equivalents to achieve a better match for your specific printing conditions.
Spot-On allows you to adjust and manage lists of spot colours and their CMYK
equivalents. The matching lists of spot colours and CMYK values are known as Spot
Colour Dictionaries. Spot-On allows you to maintain multiple Spot Colour
Dictionaries—one for each output profile on the Fiery.
N OTE : In order to use Spot-On CMYK equivalents, you must enable the Spot Colour

Matching option (see page 1-8).

Starting Spot-On
You can start Spot-On from ColorWise Pro Tools. To work with Spot-On, you must
first specify the output profile associated with the Spot Colour Dictionary that you
want to edit. However, you may switch to a different output profile at any time while
working with Spot-On.
N OTE : The Fiery allows only one user connection through Spot-On at a time.
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TO START S POT -O N
1. Start ColorWise Pro Tools and click Spot-On.

2. Choose the desired output profile and click OK.

Output profile names
appear here

The Spot-On main window appears. The CMYK values you see in the window are
calculated with respect to the specified profile.
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Using the Spot-On main window
The Spot-On main window displays a list of colour groups which represent libraries of
spot colours on the Fiery. Tool icons for working with colours appear at the top of the
window.
Cut

Copy

Download

Paste

Upload
Save

Up
Down
Print

Custom colour group

Close All

Default colour group

By default, the Fiery includes several PANTONE libraries along with a System library.
The DIC, HKS, and TOYO libraries are available with Spot-On. These factory default
libraries appear marked with the default group icon (
).
You can also add custom colour groups and colours to the Spot-On window (see
page 3-21). Added groups appear marked with the custom group icon (
). Both
default and custom groups can be opened to display their included colours.
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TO OPEN AND CLOSE A COLOUR GROUP
1. To open a colour group, click the icon to the left of the group name.

You can also open a group
by double-clicking the
blank area to the right of
the group name.
When you open a group,
all colours in the group
are displayed, and the
group icon changes
appearance.
2. To close a colour group,
click the icon to the left
of the group name, or
double-click the blank
area to the right of the
name.
3. To close all colour groups
in the list, choose Close
All from the Edit menu.

You can also close all colour groups by clicking the Close All icon above the colour list.

Working with existing colours
With Spot-On, you can view and manage existing groups of colours on the Fiery. You
can also search for a particular colour in the Spot-On list.
Colour groups in the Spot-On window appear in order of their priority. Highest
priority is given to colour groups at the top of the list. For instance, if two colours from
two different colour groups have the same name, the Fiery uses the colour from the
higher group and disregards the other colour. By managing the priority of colours in
this way, you can maintain several CMYK variants for the same spot colour.
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TO REARRANGE THE PRIORITY OF COLOURS
1. To rearrange an entire colour group, select the desired colour group.
To rearrange an individual colour, select the desired colour.

Individual spot colours are marked with circular colour icons.
2. To move the selection up or down in the list, click the Up or Down icon in the toolbar.
3. To paste the selection in a different location in the list, click the Cut or Copy icon in
the toolbar.
N OTE : The Cut operation is only available for custom colours.
4. Click the location in the list where you want to paste the cut or copied selection, and
click the Paste icon in the toolbar.

When you paste a default colour group or
colour, a warning message may appear
asking you to rename the selection. Use the
menus to choose the desired prefix and
suffix for the new name, and click OK. The
pasted selection becomes a custom colour
group or colour with the specified name.

TO FIND A SPECIFIC COLOUR
1. Choose Find from the Edit menu.

The Find dialog box appears.
2. Enter the name of the colour you want to find and click OK.

Spot-On searches for the specified colour, starting from the top of the colour list. The
located colour appears selected in the colour list.
3. To find additional colours based on the same search criteria, choose Find Again from
the Edit menu.
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Creating custom colours
Spot-On provides a number of default colour groups, such as PANTONE and DIC, in
the colour list. You can add your own custom spot colours and groups to the list.
TO ADD A NEW COLOUR OR COLOUR GROUP
1. Select the line in the group or colour list where your addition is intended.
2. Choose New Group from the Edit menu to insert a new group or choose New Colour to
insert a new colour.

A new colour group entry or colour entry appears as Untitled.
TO RENAME A CUSTOM COLOUR OR COLOUR GROUP
1. Select the Colour Name or specific colour you want to edit.

2. Type the new name exactly as it appears in the print job documents, including
uppercase and lowercase characters and spaces, as necessary.
N OTE : Default groups or colours, such as PANTONE, cannot be renamed.
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Downloading custom colour groups
You can download custom colour groups from your computer to the Fiery.
Downloaded groups are added as custom groups to the Spot-On colour list and are
enabled immediately for use on the Fiery.
TO DOWNLOAD CUSTOM COLOUR GROUPS
1. Select the line in the colour list where you want to add the downloaded group.
2. Choose Download from the File menu.

The Select file dialog box
appears.
3. Locate and select the desired
colour group, and click Open.

The downloaded group is
added to the specified location
in the Spot-On list. If you did
not specify a location, the
group is added to the top of
the list.
If the downloaded group has the same name as an existing group in the list, you are
prompted to rename the downloaded group.

Uploading custom colour groups
You can upload custom colour groups from the Fiery to your computer as ICC files.
The upload feature allows you to share a group by creating a local copy that can be
downloaded to another Fiery.
Before you can upload a colour group to your computer, it must be saved to the Fiery.
To upload a factory default group, copy and paste the group as a new custom group.
You can then upload the group as desired.
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TO UPLOAD CUSTOM COLOUR GROUPS
1. Select the name of the colour group you want to upload.
2. Choose Upload from the File
menu.

The Save As dialog box
appears.
3. Browse to the location where
you want to save the file, name
the file, and then click Save.

Editing colour values
The Spot-On Colour Search
targets the exact CMYK toner equivalents required to simulate a desired spot colour on
the printer. If an existing spot colour is not printing as desired, you can modify the
colour values as needed to achieve your intended result. Beginning with an
approximate colour, you can adjust the hue, saturation, and lightness of the colour
until you achieve a desirable match.
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TO TARGET A COLOUR USING S POT -O N C OLOUR S EARCH
1. Select a colour icon from a colour group and choose Colour Search from the Edit menu.

The Spot-On Colour Search window appears. You can also display this window by
double-clicking a colour icon in the colour list.

The current colour
appears in the centre
patch of the window.

2. To update the centre patch to a neighbouring colour that more closely matches the
target, click the corresponding neighbour patch.

Neighbouring patches represent variations from the centre patch and can be selected if
they offer a closer match to the desired colour. Clicking one of these patches updates
the centre patch to the new colour and provides a new selection of neighbouring
colours. These patches are either lightness or saturation neighbours, depending on the
option you choose in the following step.
N OTE : When you select certain colours, an exclamation point icon may appear in the

upper-right corner of the window. This icon indicates that the centre patch colour lies
at the edge of the printer’s printable gamut and may not be reproducible. In such cases,
we recommend that you use an approximate target that lies within the gamut, rather
than the out-of-gamut colour.
You can also click the centre patch to enter CMYK values directly. For more
information, see the procedure on page 3-26.
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3. Use the following techniques to control how neighbouring colour patches are
generated:
Select either Lightness or Saturation in the Colour Directions Legend.

Lightness generates neighbour patches based on darker to lighter shades of the original
colour. This variation is displayed from left to right, with the original colour remaining
in the centre of the middle group.
Saturation generates neighbour patches based on less saturated to more saturated
variations of the original colour. This variation is displayed from left to right, with the
original colour remaining in the centre of the middle group.
Choose a setting from the Colour Spacing menu to control the closeness of the
neighbour patches.

A higher setting generates neighbour patches that differ more noticeably from the
centre colour. As you get closer to your target colour, reduce the colour spacing to a
smaller value.
Select Monitor Compensation to simulate how all the on-screen colour patches will
appear when printed on paper.

This simulation depends on the monitor profile that has been configured for the
display. To specify the monitor profile, choose Preferences from the Edit menu in the
Spot-On main menu.
4. Continue adjusting the colour patch controls and clicking neighbour patches until the
desired colour appears in the centre patch. Click Print Pattern.
5. Choose Output Style, Paper Size, and Paper Tray options.

For Output Style, choose between Colour
Search Pattern and Colour Neighbour
Pattern. Colour Search Pattern prints
patches with the same pattern as displayed in
the Colour Search window. Colour
Neighbour Pattern prints patches in a three
column by eight row format.
For Paper Size, choose the size of the paper
you want to use for printing the patches.
For Paper Tray, specify the input tray for the paper you want to use.
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6. Click OK to print the patches.

The Print Pattern test page prints the following information:
• Centre patch colour CMYK value
• Colour spacing
• Lightness or Saturation neighbours selected
• Output profile selected
The goal of the Spot-On Colour Search is to find the colour values that make a printed
colour patch match a target, not the screen simulation of it. Printing a Print Pattern of
the neighbour colour patches allows you to compare the printed patches to the colour
target. Once you compare the printed patches and find the one that matches most
closely, you can then select the corresponding patch on the screen.
7. When you have selected the desired target colour in the Spot-On Colour Search
window, click OK.

The edited colour appears in the colour list of the main Spot-On window.
TO TARGET A COLOUR USING EXACT CMYK VALUES
1. Click the centre patch in the Spot-On Colour Search window.

The Set Centre Patch Colour dialog box appears.

2. Select how you want to enter the CMYK values.

The Percentages option allows you to enter colour values between 0 and 100%, in
increments of 0.5. Values out of this range are rounded to the nearest whole or half
percentage.
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The Device Codes option allows you to enter colour values between 0 and 255. This
option reflects the full range of colour values that the Fiery can actually reproduce, and
provides finer gradations of colour than are possible with Percentages.
3. Enter the C, M, Y, and K values of your specific colour in the appropriate fields.

Use the Tab key to move from field to field. As you enter each new value, the preview
patch updates to reflect the old and new colours.
4. Click OK.

The new colour appears as the centre patch in the Spot-On Colour Search window.

Using a measurement instrument to target colours
If you have the EFI Densitometer ED-100 or EFI Spectrometer ES-1000, you can
import measured colour values directly into Spot-On. This feature allows you to target
matches based on the actual colours of immediate objects, such as the red of a printed
logo or the yellow of a packaging envelope.
For best results, download and save any measurement data you have gathered with the
ED-100 or ES-1000 in its offline state. Spot-On automatically clears stored data when
it establishes a connection with the instrument. For information on downloading
stored data from the ED-100 or ES-1000, see the documentation included with the
instrument.
TO IMPORT COLOUR MEASUREMENTS INTO S POT -O N
1. Install and set up the ES-1000 or ED-100 for use with your computer.

For installation and setup instructions, see the documentation that came with the
instrument.
2. Choose Start from the Instrument menu.

The Choose Port dialog box appears.
3. For Instrument, choose the instrument you will use to take measurements. For Port,
choose the serial port connection of the instrument. Click OK.

The indicator light on the instrument flashes for a few moments as the connection to
Spot-On is established. When the flashing stops, the instrument is ready to read
measurements.
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4. Place the ED-100 or ES-1000 over the target colour, making sure to centre the sample
aperture over the colour. Press Measure to take the measurement.

The measured CMYK values are imported into Spot-On as follows:
• If an individual colour is selected in the colour list, it updates to the measured
colour.
• If a group is selected in the colour list, a new colour with the measured values is
created within the group.
• If the Spot-On Colour Search window is open, the centre patch updates with the
measured values, and the neighbour patches update accordingly.
• If the Set Centre Patch Colour dialog box is open, the measured values are imported
into the CMYK entry fields.
5. When you are finished taking colour measurements, choose Stop from the Instrument
menu.

Spot-On closes the connection to the instrument.

Saving changes and exiting Spot-On
To enable your spot colour matches for use on the Fiery, you must save your edits
before exiting Spot-On. This action ensures that all your changes to Spot-On colour
definitions are stored on the Fiery and available for use when printing documents that
contain spot colours.
The following edits do not require saving to take effect:
• Rearranging the priority level of a colour group
• Downloading a colour group
• Clearing or deleting a colour group
TO SAVE THE S POT -O N COLOUR LIST
1. Choose Save from the File menu.
2. Click Close in the upper-right corner of the Spot-On main window to exit the utility.
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Colour Setup
Use Colour Setup to set the default ColorWise settings for the Fiery. To access Colour
Setup, click its icon in the ColorWise Pro Tools main window.

Setting default ColorWise options
Colour Setup allows you to configure the default colour management settings for the
Fiery. These settings are applied to all print jobs sent to the Fiery, unless a user
overrides them for an individual job by changing settings in the printer driver. These
default settings can also be overridden using Command WorkStation or Fiery Spooler.
Colour Setup maintains a connection to the Fiery, so changes made in Profile Manager
appear automatically, and the defaults set in Colour Setup are automatically reflected
in other Fiery tools that list default settings.
The options in Colour Setup are arranged in a pattern representing the flow of colour
processing that takes place on the Fiery.

Once you have made your changes, click OK or Apply for the changes to take effect.
OK sets the new defaults and closes the window. Apply sets the new defaults and keeps
the window open. Cancel closes the window without applying any changes. For most
users, the factory defaults result in optimal colour output.
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A

A-1 Colour Measurement Instruments

Appendix A:
Colour
Measurement
Instruments

This appendix explains how to set up and calibrate the following colour measurement
instruments:
• X-Rite DTP41 automatic scanning spectrophotometer
• X-Rite DTP32 automatic scanning densitometer

Using the X-Rite DTP41 spectrophotometer
ColorWise Pro Tools Calibrator supports the X-Rite DTP41 spectrophotometer, a
device that measures density and colour data. The DTP41 communicates directly with
the Calibrator application in ColorWise Pro Tools, sending measurements to the Fiery
automatically.

Setting up the DTP41
Before you calibrate the Fiery, you must connect, configure, and calibrate the
spectrophotometer to prepare for measuring the printed patches. For additional
information about setting up and using the DTP41, see the documentation included
with the instrument.
TO CONNECT THE X-R ITE DTP41 TO THE COMPUTER
1. Turn off the computer.
2. Unpack the X-Rite DTP41 and remove the spacer from the measurement page slot.
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3. Plug the square end of the interface cable (looks like a modular phone plug) into the
serial interface connection on the side of the X-Rite DTP41.

Instrument button

Alignment mark
LED indicator

Measurement page slot
Power input

Calibration strip entrance
Serial interface connection
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4. Attach the connector to the computer.

For a Windows computer, insert the 8-pin mini-DIN end of the interface cable into
the 9-pin DB9 Connector cable adapter. Insert the 9-pin end into the COM1 or
COM2 port on the computer and tighten the screws. If the available port on your
computer is 25-pin, you must use the 8-pin-to-25-pin adapter.

Unused connector
Connect to computer

Square connector

Interface cable

Connect to adapter

For a Mac OS computer, connect the 8-pin mini-DIN plug directly into the serial port
of the computer.

Unused connector

Connect to serial port

A

A-4 Colour Measurement Instruments

N OTE : For Mac OS computers with a USB port (for example, an iMac), you need an

adapter to connect the DTP41 to your computer. For information on supported
adapters, see the X-Rite, Inc. web site (www.x-rite.com).
5. Use the AC adapter to provide power.

Plug the small connector on the adapter cable into the power input of the X-Rite
DTP41 and plug the AC adapter into the power cord. Plug the power cable into a wall
outlet.

AC adapter
Power cord

Small connector

6. Turn on the computer.
7. Calibrate the X-Rite DTP41 using ColorWise Pro Tools (see the following section).
8. Calibrate the Fiery using ColorWise Pro Tools and the DTP41 (see page 2-18).

Calibrating the DTP41
For the best colour accuracy, calibrate the X-Rite DTP41 spectrophotometer every
time you calibrate the Fiery. You can initiate the calibration sequence in ColorWise
Pro Tools Calibrator as part of the process of Fiery calibration. The computer may also
prompt you that it is necessary to calibrate the spectrophotometer.
Alternatively, you can initiate the DTP41 calibration process using the Instrument
button on the DTP41. For more information on this method, see the documentation
that came with the X-Rite DTP41.
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Multiple users can be connected to one Fiery with ColorWise Pro Tools, but only one
user at a time can use the Calibrator module. An error message appears if you try to
calibrate when another user is already using ColorWise Pro Tools to calibrate.
You will need the Colour Reflection Reference strip that is included with the
spectrophotometer. Remove the strip from its protective envelope, handling it by the
edges only. Keep the strip free of dust and smudges and always store it in the protective
envelope.
TO CALIBRATE THE X-R ITE DTP41
1. Connect the spectrophotometer to the computer and turn on power (see page A-1).
2. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
3. Choose DTP41 as the measurement method.
4. In the Get Measurements pane, click Measure.
5. In the Measurement Options dialog box, click Measure.
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6. Choose the appropriate COM port for the DTP41 from the Available Ports menu.

The Instructions area displays instructions for selecting the port.
7. Click Utilities.

The Utilities dialog box appears.

To view version and serial number information, click Show DTP-41 Info. When you
are finished, click Done.
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8. Click Calibrate DTP-41.

The Instrument Calibration dialog box appears.

9. If you have not already done so, remove the shipping spacer from the measurement
page slot.
10. Insert the end of the Colour Reflection Reference strip into the calibration strip
entrance on the DTP41. Centre the arrow on the strip below the alignment mark (see
the diagram on page A-2), and slide the strip into the DTP41 until you feel the resistance of the feed mechanism.
11. Click Read Reference in the Instrument Calibration dialog box.

The DTP41 pulls the calibration strip through automatically.
A message appears in the Status area when the calibration is finished.
12. Click Done.
13. Close the Utilities window.

This completes DTP41 calibration.
When the DTP41 requires calibration, your computer prompts you. When the
prompt message appears, click Calibrate Now and follow the instructions, starting
with step 8 on page A-7.
After calibrating the DTP41, calibrate the Fiery (see page 2-18).
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Using the X-Rite DTP32 densitometer
ColorWise Pro Tools are designed to work with the X-Rite DTP32 reflection
densitometer, which feeds colour measurements to the Fiery automatically.
N OTE : Measurements from other densitometers can be input using a simple ASCII file

format (see Appendix B).

Setting up the DTP32
Before you calibrate the Fiery using the X-Rite DTP32, you need to connect,
configure, and calibrate the densitometer to prepare for measuring the printed patches
(see “Calibrating the DTP32” on page A-10). For additional information about setting
up and using the DTP32, see the separate documentation included with the
densitometer.
TO CONNECT THE X-R ITE DTP32 TO THE COMPUTER
1. Turn off the computer.
2. Plug the square end of the interface cable (looks like a modular phone plug) into the
I/O port on the side of the X-Rite DTP32.

Square connector
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3. Attach the connector to the computer.

For a Windows computer, insert the 8-pin mini-DIN end of the interface cable into
the 9-pin DB9 Connector cable adapter. Insert the 9-pin end into the COM1 or
COM2 port on the computer and tighten the screws. If the available port on your
computer is 25-pin, you must use the 8-pin-to-25-pin adapter.

Unused connector
Square connector
Connect to computer

Connect to adapter

Interface cable

For a Mac OS computer, connect the 8-pin mini-DIN plug directly into the serial port
of the computer.

Unused connector

Connect to serial port

N OTE : For Mac OS computers with a USB port (for example, an iMac), you need an

adapter to connect the DTP32 to your computer. For information on supported
adapters, see the X-Rite, Inc. web site (www.x-rite.com).
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4. Plug the small connector on the adapter cable into the side of the X-Rite DTP32 and
plug the AC adapter into a wall outlet.

Small connector
AC adapter

5. Turn on the computer.
6. Calibrate the DTP32 (see the following section).
7. Calibrate the Fiery using ColorWise Pro Tools and the DTP32 (see page 2-21).

Calibrating the DTP32
You will need the black-and-white X-Rite Auto-Cal Strip included with the
densitometer. Calibrating the densitometer does not require ColorWise Pro Tools.
TO CALIBRATE THE X-R ITE DTP32
1. Connect the densitometer to the computer and supply power (see page A-8).
2. From the Main Menu on the X-Rite DTP32 display, press the p1 key once to reach p2.
3. Press the cal key.

Calibrating motor speed is displayed, followed by the words INSERT CAL STRIP.
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4. Insert the X-Rite Auto-Cal Strip into the 35mm slot on the front of the X-Rite DTP32—
arrow end first—until it stops or the densitometer starts pulling the strip.

Reading appears momentarily, followed by the density values and CALIBRATION OK.
The densitometer automatically returns to the MAIN MENU.

If UNRECOGNIZABLE STRIP appears, repeat the process or try cleaning the strip (see the
X-Rite DTP32 Operating Manual).
Recalibrate the DTP32 at least once per month. For critical colour, calibrate the
densitometer every time you calibrate the Fiery. The DTP32 may also warn
periodically that it requires calibration.
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Appendix B:
Importing
Density
Measurements

This appendix describes Simple ASCII File Format, which can be used to import
density measurements from measurement devices. To use your own measurement data
from an alternate measurement instrument, record your individual readings in a text
file and structure it as follows.

Simple ASCII Import File Format (SAIFF)
This format describes Status T measurement data for import into the ColorWise Pro
Tools Calibrator. The three possible file formats are:
• 1D Status T density for EFI 34 patch page
• 1D Status T density for EFI 21 patch page
• 1D Status T density for other pages (maximum of 256 patches per ink)
The file format is ASCII and has no tabs. A single space or multiple spaces are used as
delimiters. Blank lines are not allowed. Each line in the file represents four patches (C,
M, Y, K) of a specific ink value. Comments may be on any line in the file. Comment
lines must start with a hash sign (#) followed by a space. A line with a hash (#) sign
followed by any character other than a space has been reserved. Comments must be on
an entire line by themselves.
Each line of data contains five values. The first number is the sequential patch number
(for EFI 34 and EFI 21 pages) or the ink value percentage (for other pages). The four
values that follow are the density values of C, M, Y, and K of the corresponding patch.
Lines are ordered either by increasing sequential patch numbers, or by increasing the
ink percentage.
For Windows computers, the file extension must be .cm1. For Mac OS computers, the
file type must be ‘TEXT’.
Measurement data in EFI 34 and EFI 21 are paper-relative. For other pages, if the first
line corresponds to zero ink value, the Calibrator assumes that the measurement data is
absolute and adjusts it to become paper-relative by subtracting the density values of the
first line from the remaining patches.

B

B-2 Importing Density Measurements

Example of 1D Status T density for EFI 34 patch page
This file format is used to specify the Status T density measurements of the EFI 34
patch page. The value in the first column is the patch number. The first patch must be
1 and the last must be 34.
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST34
# Cyan
Magent Yellow Black
1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(…more data…)
33 1.6700 1.3400 0.8900 1.6700
34 1.7200 1.4300 0.9300 1.7500

Example of 1D Status T density for EFI 21 patch page
This file format is used to specify the Status T density measurements of the EFI 21
patch page. The value in the first column is the patch number. The first patch must be
1 and the last must be 21.
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST21
# Cyan
Magent Yellow Black
1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(…more data…)
20 1.6700 1.3400 0.8900 1.6700
21 1.7200 1.4300 0.9300 1.7500
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Example of 1D Status T density for an arbitrary page
This file format is used to specify the Status T density measurements of a user-defined
patch page. The value in the first column is the ink/toner percentage of the patch. The
first percentage must be 0 and the last percentage must be 100. The percentages must
increase in between.
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST
# percnt Cyan Magent Yellow Black
0.0000 0.0300 0.0400 0.0200 0.0400
0.3922 0.0600 0.0700 0.0800 0.0700
1.1765 0.1000 0.1000 0.1000 0.1000
(…more data…)
98.0000 1.6700 1.3400 0.8900 1.6700
100.0000 1.7200 1.4300 0.9300 1.7500
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